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If it’s January, this must 
be Macworld. This month, 
newly elected Vice President, 
George Canellis and long-
time Program Coordinator, 
Rick Matteson are headed 
to San Francisco for 
Apple’s annual five-day 
Macintosh love-fest, 

Macworld Conference and Expo. While 
attempting to take in all that’s new and exciting 
in the world of Macintosh hardware and soft-
ware, they will also be attending some user 
group-specific conferences aimed at providing 
MUG leaders with helpful information for run-
ning their groups in the 21st Century.

“We will try to send daily, recorded, on-the-
spot reports of the most newsworthy show 
highlights in the hardware, software and service 
areas back to LIMac,” Rick said, “provided the 
computer and electronic gods will tolerate us.” 
He went on to say that, if all goes according to 
plan,“Bradley will be able to post these reports 
on our Website and will conduct a ‘wrap-up’ 
presentation at the regular Friday general 
meeting on January 12th.”

George added, “All these great plans hinge 
on whether or not we are still awake at the end 
of the day. Spending six to nine hours on the 
show floor and at various conference sessions 
(January’s Meeting continues on Page 3)

At the December presentation, 
our own Al Zygier once again 
treated us to a video presenta-
tion. This was a video history 
of LIMac from origin. Al 
did a fantastic job of piecing 
together footage of various 
clips he had taken over 

the last two years. It included 
interviews with the founders, and the LIMac 
board. Also included were shots of some of the 
early members, and how they influenced the 
development of LIMac. Al also had interviewed 
people who described how they found LIMac. 
(All of the people said they were so impressed 
that they joined immediately). One of the items 
people found very interesting was the com-
parison of the original Forum, and the present 
day Forum. The services that LIMac provides 
for its members were emphasized many times 
in the video. It should be pointed out that this 
group has developed a camaraderie of members 
helping other members. 

The video noted that several of our  
members and board members have given 
tremendous amounts of their time to help the 
group, and individuals in the group. These 
included: Bill Medlow our President and all 
past Presidents; Bradley Dichter our Technical 
Advisor; Mo Lebowitz, the Forum Editor/
Designer; Donald Hennessy who has been Vice-
President (and now Treasurer); Max Rechtman 
our long-time-past Treasurer and User Group 
Ambassador; and many others.

You really had to be there to appreciate 
this great video production. Many thanks to  
Al  Zygier for giving so much of his time  
and talent. 0

–Scott Randell

January

12

General meeting time schedule:
Meetings are held at The New York Institute of Technology, 
Building 300 (Anna Rubin Hall), Old Westbury, Long Island.
Meetings start promptly at 7:00 p.m.
Bradley Q&A 7:00–7:30 p.m. 
Beginner’s Q&A 7:00–7:30 p.m.
Featured presentation 7:30–8:20 p.m.  
followed by announcements and raffle drawings.
SIG (Special Interest Group) 
meetings 8:30–10:00 p.m.
Photoshop SIG:  (TBD)
Multimedia SIG: Fun with family videos.

MacBasics SIG: Taking an introductory 
look at the iLife package, consisting of 
GarageBand, iDVD, iMovie HD, iPhoto, and 
iWeb. What can we use them for? What 
sort of fun can be found in this versatile 
package?
| In bad weather, call (516) 686-7789.
| The next LIMac board meeting will be at 
the Plainedge Library, (516) 735-4133, 
on Wednesday, January 17th, at 8 p.m.  

Send your $36 check to: 

LI Macintosh Users Group, 

P.O. Box 2048 

Seaford, NY 11783-0180
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President’s MessageBradley’s Tech Session
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Bill Medlow
President
ArchBill@optonline.net

| My daughter in college has a 15" 
PowerBook, about a year and a half old and 
we bought a replacement battery online. It 
works fine, but for the longevity of the bat-
tery, is it better to leave it plugged in or let it 
run down?
Some 15"PowerBook G4 batteries were faulty, 
so check out: https://support.apple.com/ibook_
powerbook/batteryexchange/ Then see: http://
docs.info.apple.com/article.html?artnum=303035 
which relates to a firmware update of the 
PowerBook for better battery life. Also read: 
www.apple.com/batteries/notebooks.html. 
Basically, it says to not leave it plugged in all 
the time and give the battery a little exercise by 
discharging it fully once a month. Personally, I 
don’t agree with the ‘once a month’ part, once 
or twice a year (depending on usage) should 
be OK. Read: http://docs.info.apple.com/article.
html?artnum=86284 about calibrating the 
battery for best performance. The battery 
Widget is handy for keeping a basic look at your 
battery’s life. For a good $15 shareware utility, 
check out MiniBatteryLogger at: www.emeral-
dion.it/software/macosx/minibatterylogger/. For 
the rest of you with similar 15"PowerBook G4 
Aluminum, I suggest the 16% extra-strength 
models from Newer Technology. Not only do 
they last longer between charges, they can be 
recharged more times. See: www.newertech.
com/products/pbg4_batt_al15.php.
| I picked up the Adobe Creative Suite about 
two years ago. It was the education version, 
which can’t be upgraded. I’m now con-
sidering buying a Intel Core 2 Duo-based 
MacBook. I’m hesitate to buy the new 
Creative Suite 2 if it doesn’t work on the new 
laptop.
It does work, just not optimally. The next ver-
sion, Creative Suite 3, expected around April 
2007, would be Universal Binary and should 
run twice as fast as the now current CS2, not 
to mention having assorted feature advantages 
one might expect of a next generation product. 
Not only all that, but Intel is expected to intro-
duce new processors every four months, so 
there could be an updated MacBook by April, 
as well. Who knows what other hardware 
tweaks Apple might have in store for the next 
generation as well. There is even speculation 
that Apple may introduce an ultra-portable and 

TubeSock 1.0.1 
(A Review)
By Christopher Breen
Ever been frustrated 
in your inability to 
download the cool Flash-

based videos you find on YouTube? And wouldn’t 
it be nice to watch them on the go? TubeSock 
($15, stinkbot.com) may be just the thing for you.
After launching TubeSock, you copy and paste 

the URL of any YouTube video (or just the 11-digit 
sequence of numbers and letters after the term 
watch ?V= in the URL) into the app’s navigation 
field and then click on the Preview button to 
verify that it’s the right video. An even easier way 
to add a video to TubeSock is by choosing the 
Integrate With Safari command on the TubeSock 
menu – doing so brings up a browser window with 
a button you can drag into your Bookmarks bar 
(it works with Apple’s Safari and Mozilla FireFox). 

Then, when you see a video you want to convert, 
click on the Show In TubeSock bookmark to send 
the YRL directly to TubeSock.
Once you’ve chosen a video, click on the output 
settings (H.264 for iPod; MP4 for PSP; and so 
on) and then select the destination for the video 
(your iTunes library, your Movies folder or another 
dirctory of your choosing.) Click on the Save 
button and TubeSock will download the Flash file 
and convert it to your chosen format.

If you’re not blessed with an iPod that plays video, 
TubeSock’s MP3 option will download the video 
and save just its audio track. Download any of 
the thousands of music videos found on YouTube 
and you’ll understand the power and the glory of 
this feature.
Thanks to TubeSock, I’ve now got a folder full of 
very cool video clips – appearances by the Rolling 
Stones and Howlin’ Wolf on Shindig, George 

(Q&A continues on Page 3.)

The best message I can give you is: It is all  
anticipation – like waiting for Christmas, 
Chanuka, your next vacation, or birthday.

Macworld SF is just around the corner and 
we will be bringing it to you at our January 
meeting.

Hope you and your family had a great  
holiday. Happy New Year! 0

(TubeSock continues on Page 3)

LIMac election results for 2007:
Bill Medlow President
George Canellis Vice President 
(and User Group Ambassador)
Donald Hennessy Treasurer 
(and Membership Chairman)
Bernie Flicker Secretary
Appointed Board members:
Bradley Dichter Technical Advisor
Rick Matteson Program Coordinator
The remaining board members at large are: 
Geoff Broadhurst, Al Choy, Scott Randell, Harold 
Silvers, Al Zygier, Richard Hickerson, Fred Fertik 0

thin MacBook/MacBook Pro with a 12" wide-
screen display. On top of that, Apple should 
have Mac OS 10.5, AKA Leopard available 
around the same time, so if you can wait for 
Leopard and Adobe CS3, then that would be an 
ideal time to make the purchase. Just in time 
for final exams in May. I heard there may be a 
public beta available by the time you read this. 
Hopefully, Adobe will still offer an educators’ 
discounted version when CS3 ships.
| I recently received an e-mail with an 
attachment that I couldn’t open. The file-
name extension was .sit
Your e-mail software couldn’t open it directly, 
but there is a good chance some other program 
you have can. If you just save the attachment, 
to say, the Desktop, and then open it with 
StuffIt Expander, then you should be able 
to open the contents of the archive. Modern 
Macs don’t have the free StuffIt Expander, but 
machines upgraded from older Mac OS ver-
sions, should still have some version of StuffIt 
Expander hanging around, perhaps in their 
Utilities folder. In any case, if you have no  
version or a old version, you can download and 
install a free copy of the expander. See: www.
stuffit.com/mac/expander/download.html. 

Understanding the 
hierarchy of object 
transparency Adobe 
InDesign CS2:
If you select an 
image with the 
Direct Selection tool, 
you can lower the 
Opacity and change 
the Blending Mode 
of just that image 
without changing 
the Transparency of 
the frame itself. So 
if the frame has any 
Fill or a Stroke, they 
will still be 100% 
Opaque. But if you 
select a frame with 
the Selection tool and 
apply Transparency, 
the frame and 
everything contained 
in it will also be 
Transparent. Don’t 
believe me?

Select a frame 
with a Fill and 
Stroke and lower 
its Opacity in the 
Transparency palette 
(Window>Transpar-
ency). Now, using 
your Direct Selection 
tool, select an 
image from another 
frame that has 
no Transparency 
applied. Copy the 

 TIPS!

image (Edit>Copy) 
and select your 
Transparent frame 
with the Selection 
tool and paste the 
opaque image into it 
(Edit>Paste Into). 

The image takes 
on the Transparency 
of the frame into 
which it has been 
pasted.

–Jeff Witchel

Making a ghosted 
panel for text in 
Adobe InDesign 
CS2:
If you want to make 
a ghosted panel 
for text by lowering 
the Opacity of a 
Text Frame in the 
Transparency palette 
(Window>Transpar-
ency), everything in 
the frame, including 
the type, will be 
Transparent.

Type all your 
text in a separate 
Frame. Center your 
Type Frame to the 
ghosted panel by 
using Horizontal 
and Vertical 
Center Alignment 
in the Align palette 
(Window>Align) 
Then Group the 
two objects 
(Object>Group) so 
both are working as 
a single unit when 
moved with the 
Selection tool.

–Jeff Witchel
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The full $80 StuffIt Deluxe 11.0.1 (by the way, 
Allume, formerly Aladdin Systems, is now a 
division of Smith Micro Software, perhaps 
better known for QuickLink and FAXstf, 
from STF Technologies) is not required. Mac 
OS 10.4 is required for this release, which is 
Universal Binary. Users of Mac OS 10.3.x can 
use StuffIt Expander 10.0.2. Besides e-mail 
attachments, you will find plenty of software 
downloads in .sit format, despite Apple now 
embracing the more standard .zip archive 
format. The Finder can create and extract 
files from .zip files. One last thing – you 
may also find .sitx files as well, also a StuffIt 
format.
| AppleWorks’ word processor locks up if 
I don’t save often when I’m working on a 
document with a lot of photos. I’m using 
the latest version 6.2.9. Is my copy cor-
rupted? It seems OK if I save after putting 
in a few at time.
It is more likely that it is merely overtaxed 
by too many images. It is not a page layout 
program that assembles its pages by main-
taining links to the external image files, but 
it attempts to embed the images within the 
document. Memory management becomes a 
problem with more than a few small images. 
Keep in mind the total, in megabytes, of all 
the images you are adding to this document. 
If you are putting together a composition 
such as this, take a close look at the size and 
resolution of the images you are inserting. 
Perhaps you need to resize and resample a 
copy for use in this document. If the images 
are coming from iPhoto, you can export them 
and save them at a smaller size, better suited 
to the dimensions used in your document. A 
six megapixel camera generates fairly large 
files, totally wasting space when dropped 
into and scaled down to a 2.5"-wide column 
like you see in the Forum. If you are getting 
too fancy for AppleWorks, then you may want 
to consider using another program better 
suited for the image laden. Of course Adobe 
InDesign CS 2 comes to mind, but you can 
consider something cheaper like Apple’s 
Pages 2, part of the iWork ‘06 bundle. At $79 
for the bundle with Keynote 3, it’s really quite 
easy to work with and it opens AppleWorks 

files. It has built-in iLife Media Browser. Check 
it out at: www.apple.com/iwork/pages/. Think 
of it as “InDesign Lite,” particularly when 
you think of InDesign CS2’s list price of $699. 
Until you buy something else, have you been 
trimming the contents of your ~/Documents/
AppleWorks User Data/Starting Points/Recent 
Items folder. It gets really full of aliases to files 
you have been working on. Which reminds me, 
do you have the Auto-Save feature turned on in 
the Files section of AppleWorks Preferences? It 
might help.
| I hear that now there is a program to 
extract recorded shows off your series 2 or 
3 TiVo and saves it as a MPEG format file. 
What do I need to take that and make  
a DVD that will play in a regular-set-top 
DVD player?
The program in question is TiVoDecode 
Manager. All you need is Roxio Toast Titanium. 
I’m running version 7.1.2, but it should work 
with older releases. Set it for Video mode and 
DVD-Video format and Auto-play on insert and 
drag the MPEG-2 format .mpg file into the Toast 
window. Depending on the length of the video, 
you may need a dual-layer burner. Otherwise 
you’ll have to use Custom encoding and set the 
average and maximum bit rates way down in 
order to fit the movie on a single layer DVD. 
For a 3 hour and one minute movie I used as a 
test, I had to use 2.5 and max 3.0 Mbps before 

 TIP!
Keep it Running
Many people don’t 
think of the Finder as 
an application, but 
it is. You will see it 
in the Dock, just like 
all other applica-
tions, and if you 
open up the Force 
Quit Applications” 
window by pressing 
Command-Option-
Escape, you will 
see it listed with 
all of the other 
applications that are 
currently running. 
This is important to 
remember in case 
the Finder stops 
responding.

If you select the 
non-responsive 
Finder in the Force 
Quit Applications 
window, the Force 
Quit button at the 
bottom will change 
to Relaunch. Once 
clicked, the system 
will attempt to 
quit the Finder and 
relaunch it. This will 
often clear up any 
difficulties.

If you continue to 
run into seemingly 
random problems 
with your system 
open up the Utilities 
folder inside the 
Applications folder, 
and launch Disk 
Utility. Select your 
boot drive, and 
click Repair Disk 
Permissions under 
the First Aid section.

 TIP!
Fade to nothing in 
Adobe Illustrator 
CS2:
Create a gradient in 
the Gradient palette 
using the color you 
need plus white. With 
the Gradient tool 
(G), fill the object 
with the gradient, 
and then create 
an opacity mask to 
gradually change the 
object to transparent.

To do this, create 
a rectangle with the 
Rectangle tool (M) 
that’s slightly bigger 
than your object and 
position the recangle 
over the object. Fill 
the rectangle with a 
black-to-white gra-
dient, positioning the 
black over the area 
of the original object 
where its gradient 
is white. 

Select both 
objects with the 
Selection tool 
(V), and from the 
Transparency palette 
(Wndow>Transpar-
ency). Use the flyout 
menu to choose 
Make Opacity Mask. 
If you need to adjust 
the effect, click on 
the mask thumbnail 
in the Transparency 
palette, and then 
adjust the position of 
the rectangle and/or 
the gradient.

–Layers Magazine

THAT’S IT CHARLIE…YOU’RE OFF MY BOOKMARKS!

then sampling Macworld’s and San Francisco’s 
nightlife tends to wear a person out.”

All we can say is, keep checking LIMac’s 
Website for updates and come to the January 
general meeting for the scheduled wrap-up.

–Rick Matteson

(January’s Meeting continues from Page 1)

(Q&A continues on Page 7)

More of Bradley’s Tech Session 

(TubeSock continues from Page 2)
Harrison’s induction into the Rock and Roll Hall 
of Fame with Prince completely tearing it up on 
the final solo of “While MyGuitar Gently Weeps,” 
and Willie Mays’s public service announcement 
about the dangers of blasting caps (you had to 
be there). 
TubeSock isn’t the only way to get videos out of 
YouTube and into a more Mac- and iPod-friendly 
format, but it’s currently the best method. A 

promising free alternative, PodTube, still 
needs a lot of work, and other methods involve 
downloading YouTube videos via Safari’s Activity 
window or Terminal, and then converting those 
videos – real hassle. If you want offline access 
to YouTube videos, $15 is a small price to pay for 
TubeSock’s convenience. 0

PTHPasteboard 
Really Returns, 
Adds Pro Version

A Review by Matt 
Neuburg (matt@
tidbits.com)
Paul Haddad’s 

PTHPasteboard 4.0 is here, it’s free, and it’s 
better than ever. PTHPasteboard is a simple 
but powerful automatic multiple pasteboard: 

basically, every time you choose Copy or Cut in 
any application, PTHPasteboard remembers the 
clipboard contents, so that you can later paste 
that item even though you have subsequently 
tromped on the system clipboard with another 
Copy or Cut. With PTHPasteboard, it becomes 
trivially easy to collect multiple items from one 
place or many places and paste them separately 
elsewhere; unless you’ve experienced it, you may 

The LIMac On-Line Forum/JANUARY 2007

(PTHPasteboard continues on Page 4)

DAN DANGLO
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 TIP!

not realize how much easier your entire workflow 
becomes when suddenly there is no need to 
plan or hesitate before copying, because all 
your recently copied items are available to you, 
everywhere, all the time.

PTHPasteboard 4.0 is a significant rewrite. 
Options are now managed through a System 
Preferences pane. The saved clipboard items 
(referred to as “buffers”) are accessed through 

a window. This window can be constantly present, 
or it can be manually summoned and hidden, 
or – this is what I use – it can appear temporarily, 
sliding into the screen from the side or bottom 
when you hover the mouse over that region (like 
the Dock’s hiding behavior). Frequently used 
material can be stored in additional windows 
(rather like the old Scrapbook). Windows are 
searchable. You can learn what application a 
buffer was copied from, and when. Hot keys can 

be defined to show or hide particular windows 
or paste particular buffers; I find the simplest 
approach is to summon the window through a 
hot key and then type a buffer’s number to paste 
it. (So, for example, to paste buffer 2 from the 
main PTHPasteboard window, I first press Shift-
Option-Command-V, which shows the window; I 
then type “2”, which pastes that buffer and hides 
the window.)

If you want even more power, or simply want to 

assuage your guilt over getting so much for free, 
you can pay $20 to upgrade to PTHPasteboard 
Pro. This adds syncing, whereby the contents 
of clipboard windows can be shared between 
machines across the local network. It also adds 
filtering, letting text pass through various pre-
defined transformations as it is pasted.

 (Personally, I’d prefer a feature that lets me 
write my own transformations in some
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Helen and
Sheldon Gross
shel9@verizon.net

Note: Sore Eyes site 
referrals are for your 
information only. 
Neither the Grosses 
nor LIMac endorse 
any of the sites or 
their products.

Happy New Year! Hope it’s a good one for all.
We finally found the problems (and solved 

them) relating to an Intel Mac. Up to this point 
(about four months), we have not really experi-
enced problems; but of course we hadn’t been 
looking too hard.

It started when our scanner, a four-year-old 
Epson, started to give us trouble.

It was a nice flatbed connected by a USB 
cable, but some things did not work. The 
various software programs for OmniPage and 
other items were not functioning. Obviously 
I needed to contact various software devel-
opers for updates. The scanner itself seemed 
to work. However we needed a new scanner 
upstate, so it seemed time to get a new one. 
We bought a new Canon with capabilities for 
scanning slides, film, etc. – even though in 
the last six years I haven’t used that capability 
once. However, I always think I might need it.  
The new CanoScan was lovely and simple but 
it didn’t work. After numerous hours on the 
telephone with both Apple and Canon, I made 
a remarkable discovery: this scanner worked 
beautifully with the Power PC laptop and so, 
clearly, I needed update software from Canon. 
(This actually means ArcSoft, OmniPage, and 

      Sore Eyes
others too numerous to mention.) At this point 
I found another advantage to Apple. The appli-
cation from Apple, Image Capture, let me scan 
documents with the new scanner, even though 
I couldn’t do so with the scanner software.

I started to fool around with PhotoShop 
Elements. It too, did not work. I was still using 
Version 3 and Adobe said with OS 10.4.8, I 
needed to upgrade. But of course, Version 4 
didn’t work either. Obviously, the Rosetta 
program included with the Apple software 
update was not performing as promised. Apple 
indicated that I should reinstall the Operating 
System. Struggling with this took forever. My 
original Apple disks died during the reinstall. 
What’s more I couldn’t get Disk 2 out of the 
computer.

At any rate, we marched down to the Apple 
Store. In New York City, the Apple Store is 
open 24/7 and we were able to get an appoint-
ment within the hour. The wonderful genius 
at the Genius Bar reinstalled OSX 10.4.8 and we 
returned home. Then we had to reinstall the 
updates for the Apple Software, and of course 
the PhotoShop and scanner software, but at this 
point, everything works. We’re glad we use 
Apple!!!! 0

LIMac is a proud member of the Peachpit User 
Group Partner Program and as such all LIMac 
members are entitled to a 30% discount off 
the list price of any of Peachpit’s books. When 
ordering at their Website (www.peachpit.com) 
at checkout, right before you enter your credit 
card number, you must enter the user group 
coupon code UE-23AA-PEUF (case-sensi-
tive). This coupon code is an exclusive offer 
that may not be used in conjunction with any 
other coupon codes. Through the generosity 
of Peachpit, LIMac will also be receiving free 
books as raffle prizes. Look for them on the 
prize table when you’re purchasing your raffle 
tickets at the monthly meeting.

The following vendor offers require a top-
secret user group offer code. If you are inter-
ested in any of the following products, please 
send an e-mail to me at gwc11713@optonline.net.
MacAddict magazine Starting with the 

User Group News

February 2007 issue, MacAddict will become 
Mac|Life, the new Mac magazine that changes 
all the rules. This publication recognizes 
Apple’s dynamic role in work, play and life, 
and will appeal to core Apple users. Features 
include in-depth how-tos, stunning design and 
exclusive information; Mac|Life is the ultimate 
magazine about all things Apple. This offer 
is for a one-time Apple User Group member 
charter subscription rate of $14.95 for 12 issues, 
a savings of 40% off the basic subscription price. 
This offer is valid through February 28, 2007. 
(www.macaddict.com)
Other World Computing offers 5% off any 
award-winning, space-saving mini Stack 
storage/port expansion solution from 
NewerTech and 10% off any NewerTech 
NuPower high capacity Powerbook and iBook 
replacement battery. MiniStack prices start at 

A good tip if ever 
you lose your digital 
camera: 
Maybe you will have 
a better chance of 
it being returned 
to you.

Simply make a 
large-type word doc-
ument on your com-
puter that inludes the 

following:
IF FOUND, PLEASE 
RETURN THIS 
CAMERA TO: 
(insert name/
address/tel./fax/e-
mail). THANK YOU!

Print it out as 
large as possible on 
an 8-1/2“x11” sheet 
and then photograph 
it with your digital 
camera as the first 
image on your 
memory card(s), and 
do not delete them! 
This way, if you and 
your camera ever get 
separated, hopefully 
whoever finds it will 
see the image and be 
kind enough to return 
it to you!

You could also 
hand print the 
wording on plain 
paper, blackboard, 
living room wall or 
whatever to accom-
plish the same thing.

For example, my 
format is as follows:
IF FOUND, PLEASE 
RETURN TO:
FRED R. FERTIK
25 FAIRWAY DRIVE
OLD BETHPAGE, NY 
11804(516) 694-
2271 FAX: (516) 694-
8986 FRFERTIK@
FERTIK.NET. THANK 
YOU!!

An added advan-
tage of the tip is that 
if someone only loses 
their memory card 
(and not the camera), 
there’s a good 
chance the memory 
card (if found) will be 
returned. (Needless 
to say, please use 
your own information 
or I’ll be receiving 
digital cameras up 
the ying yang!)

–Fred Fertik

George Canellis
gwc11713@optonline.
net

(PTHPasteboard continues from Page 3)

(PTHPasteboard continues on Page 5)

(User Group News continues on Page 6)

mailto:shel9@verizon.net
http://www.peachpit.com
mailto:gwc11713@optonline.net?subject=User Group News
http://www.macaddict.com
http://www.apple.com/macosx/features/imagecapture/
http://www.adobe.com/products/pdfs/intelmacsupport.pdf
http://www.adobe.com/products/photoshopelmac/
http://www.apple.com/rosetta/
http://www.apple.com/retail/fifthavenue/
http://www.nuance.com/omnipage/mac/
mailto:gwc11713@optonline.net?subject=User Group News
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How do you tell one typeface 
from another? If you’re trying 
to distinguish Helvetica from 
Times Roman, the difference is 
obvious. In other cases, however 
– especially between text designs 
having similar characteristics 
– the differences can be subtle 
and difficult for the less experi-
enced eye to see.

One important step in 
training your eye to notice the 
details that set one design apart 
from another is to examine the 
anatomy of the characters that 
make up our alphabet.

As in any profession, type 
designers have a specialized 
vocabulary to talk about the 
different parts of letters. You 
need not commit the entire list 
to memory, but familiarizing 
yourself with this terminology 
will make it easier to communi-
cate about typefaces and their 
characteristics. It will also help 
educate your eye to recognize the underlying 
structure of various designs and the differences 
among them.
| Arm/leg An upper or lower (horizontal or 
diagonal) stroke that is attached on one end and 
free on the other.
| Ascender The part of a lowercase character (b, 
d, f, h, k, l t) that extends above the x-height.
| Bar The horizontal stroke in characters such 
as A, H, R, e, and f.
| Bowl A curved stroke which creates an 
enclosed space within a character (the space is 
then called a counter).
| Cap Height The height of capital letters from 
the baseline to the top of caps, most accurately 
measured on a character with a flat bottom. 
| Counter The partially or fully enclosed space 
within a character.
| Descender The part of a character (g, j, p, q, y ) 
that descends below the baseline.
| Ear The small stroke that projects from the 
top of the lowercase g.
| Link The stroke connecting the bowl and 
loop of a two story lowercase g.
| Loop The lower portion of the lowercase g.

| Serif The projections extending off the main 
strokes of the characters of serif typefaces. Serifs 
come in two styles: bracketed and unbracketed. 
Brackets are the supportive curves which con-
nect the serif to the stroke. Unbracketed serifs 
are attached sharply, and usually at 90˚ angles.
| Shoulder The curved stroke of the h, m, n.
| Spine The main curved stroke of the S.
| Spur A small projection off a main stroke 
found on many capital Gs.
| Stem A straight vertical stroke (or the main 
straight diagonal stroke in a letter which has no 
verticals).
| Stress The direction of thickening in a curved 
stroke.
| Stroke A straight or curved line.
| Swash A fancy flourish replacing a terminal 
or serif.
| Tail The descender of a Q or short diagonal 
stroke of an R.
| Terminal The end of a stroke not terminated 
with a serif.
| x-height The height of lowercase letters, 
specifically the lowercase x, not including 
ascenders and descenders. 0

 
well-known scripting language.)

Try PTHPasteboard, for its clarity, its power, 
and its wonderful “set it and forget it” ease 
of use, not to mention its (lack of) price. 
PTHPasteboard 4.0 is a universal binary, and 
requires Mac OS X 10.4 Tiger. It’s free; the Pro 
version costs $20 with a free 30-day trial period. 
(http://download.pth.com/PTHPasteboard/
PTHPasteboard.prefPane.dmg). 0

(PTHPasteboard continues from Page 4)
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Ilene Strizver
Ilene@thetypestudio.com

Ilene Strizver, founder 
of The Type Studio, 
is a typographic 
consultant, designer, 
writer and special-
izing in all aspects 
of typographic com-
munication, from the 
aesthetic to the tech-
nical. Ilene conducts 
Gourmet Typography 
Training internation-
ally. For more infor-
mation, visit www.
thetypestudio.com.

Alma Orenstein

DEC. 
SHUFFLE
WINNER

The Anatomy of a Character

LIMac’s Privacy 
Policy:
General Information 
Collection: LIMac 
acquires mailing and 
e-mail addresses 
from our members 
and no other outside 
sources in order to 
communicate with 
our membership. We 
use this information 
to send out the LIMac 
Forum and to send 
occasional notices.
Disclosure to Third 
Parties We do not 
disclose mailing 
addresses, e-mail 
addresses or any 
other confidential 
information to third 
parties.
Questions If you 
have any questions 
concerning LIMac’s 
Privacy Policy, please 
e-mail them to about-
limac@aol.com. 0

cap height
X-height

BAR

ARM BOWL
COUNTER

DESCENDER

LOOP
LINK

EAR

SERIF

SHOULDER

SPINE

SPURSPUR

STEM

STRESS

STROKE SWASH

TAIL

TERMINAL

ASCENDER

The Board of Directors: See page  3  for details.

DEC. 
iPOD

WINNER

Bill Medlow

http://download.pth.com/PTHPasteboard/PTHPasteboard.prefPane.dmg
http://download.pth.com/PTHPasteboard/PTHPasteboard.prefPane.dmg
mailto:Ilene@thetypestudio.com
http://www.thetypestudio.com
http://www.thetypestudio.com
mailto:aboutlimac@aol.com?subject=LIMac Privacy Policy
mailto:aboutlimac@aol.com?subject=LIMac Privacy Policy
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 TIP!
Too Many Apps:
A reader is con-
cerned about his 
Mac’s performance. 
He writes: “Do too 
many apps slow 
down a Mac? System 
Profiler lists 375 on 
my G5 iMac. I could 
remove tons of them 
with AppZapper, but 
would that quicken 
my system?”
I can answer that 
question with a defi-
nite maybe. I waffle 
and weave because 
the absence of an 
application may 
help performance 
depending on what 
the application is 
doing in both its work 
and off-hours.

For example, if 
the application runs 
some background 
job that’s placing 
demands on your 
Mac’s processor, 
the existence of 
the application 
could slow down 
performance. I use 
Ambrosia Software’s 
terrific screen cap-
ture tool, SnapzPro X 
2. A gander at Activity 
Monitor tells me 
that even though I’m 
not doing anything 
with it, it’s taking up 
about 0.50 percent 
of my CPU’s attention. 
I’m not suggesting 
that Snapz is doing 
any harm with such 
pitiful demands, I 
point to it only to 
illustrate what back-
ground processes 
can do.

$74.95 and NuPower Replacement PowerBook 
and iBook Batteries start at $99.95. Valid 
through March 31, 2007. (www.macsales.com).
Softpress & Have|Host 25% off Freeway 4 and 
Hosting. Softpress and Have|Host have com-
bined their efforts to offer great discounts for 
Apple user groups to get Freeway 4, the award-
winning Web design application and first-class 
Mac-friendly Web Hosting. Design your site 
visually, let Freeway 4 write standards-compliant 
code and upload automatically to your Web 
space.Members pay only $210 (US) for Freeway 
4 Pro, $75 (US) for 4 Express, and get a 25% dis-
count off all full-priced hosting contracts from 
Have|Host. To purchase, get the relevant codes 
from your User Group Leader and enjoy one or 
both offers; it’s up to you. This worldwide offer is 
valid through March 31, 2007. Freeway software 
(www.softpress.com). Have|Host services (www.
havehost.ca)
No Starch Press 40% off all No Starch Press 
Books. Check out the new paperback version 
of the bestselling Cult of Mac, a celebration of 
all things Mac. Also available: the hardcover 
edition of The Cult of Mac, Apple Confidential 
2.0, The Cult of iPod, Just Say No to Microsoft, 
Steal This Computer Book 4.0 and many more! 
User Group members can visit the Website and 
view the complete online catalog, then use the 
voucher code to receive a special 40% discount 
on all No Starch Press books. Voucher code 
500375983. View the No Starch Online Catalog 
(www.nostarch.com). This worldwide offer is valid 
through March 31, 2007.
Migilia 25% off Miglia TV Products. Miglia 
Technology offers innovative audio, video and 
communications products. If you are interested 
in watching, recording, pausing or rewinding 
live TV on your Mac, then Miglia’s TVMicro, 
TVMini HD and TVMax are for you! If you’d 
like to leverage the power of Internet telephony 
and make free worldwide phone calls, the 
Dialog products may interest you. For those 
into audio, check out the HarmonyAudio, 
Microsound and Diva products! Migilia offers 
User Group members the following specials, 
each at 25% of regular prices: TVMini HD 
– regularly $199 (US), user group price $149 

(US). TVMicro regularly $99 (US), user group 
price $74 (US) TVMax: regularly $249 (US), 
user group price $187 (US) HarmonyAudio: 
regularly $199 (US), user group price $149 (US) 
Microsound: regularly $29 (US), user group price 
$19. (US) Dialog: regularly $79 (US), user group 
price $59 (US) Dialog+: regularly $99 (US), user 
group price $74 (US) Diva 2.1: regularly $99 
(US), user group price $74 (US). Learn more 
- order online (www.miglia.com/products/aug_
list.html). This North America-only offer is valid 
through March 31, 2007. 
Looking for information on a past offer? 
Tom Piper, Apple User Group Advisory Board 
vendor coordinator, publishes a single page 
with all current offers, expiration dates and 
codes. Also, be sure to subscribe to Tom’s Apple 
User Group Market Report podcast, a great 
source for information about Apple user groups, 
vendor discounts, special events and more.
| Issue nine contains interviews with Leslie 
Ayers, Stacey Levy and Mike Basseilio of 
Mac|Life.
| Issue ten includes an interview with Lynn 
Poos, Apple User Group Advisory Board 
member, talking about the UGU event, 
Macworld and more.
Current offers (http://homepage.mac.com/ugab/
offers/vendorcodes.htm).
Password: offer. Apple User Group Market 
Report Podcast: (http://homepage.mac.com/
ugab/resources.html.
The MUG Store: Redesigned for Even Greater 
Savings. The Apple MUG Store has been rede-
signed to offer you even more great deals. If you 
haven’t looked in a while, check out the Apple 
MUG Store. You’ll find great prices, lots of 
special offers, blowouts on Apple products and 
more!

Be sure to give applemugstore.com a peek 
every so often. When you buy from the MUG 
store, the store sets aside one percent of your 
group members’ purchases, which your group 
can use to buy anything from the store! User 
ID: ipod. Password: nano. (http://www.appl-
emugstore.com). This U.S.-only offer is valid 
through January 31, 2007. For information about 
vendor offers and more visit: http://homepage.

 More of Mac User Groups News
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Send your $36 check to: LI Macintosh Users Group, P.O. Box 2048, Seaford, NY 11783-0180

Apple Store guys visit 

With that in mind, 
put Activity Monitor 
to good use and see 
which background 
processes appear 
at the top of the list 
when you sort by % 
CPU. If they’re apps 
you can do without, 
getting rid of them 
may help perfor-
mance.

If an application 
requires a login 
item – you have a 
backup program that 
requires a sched-
uling component that 
monitors your Mac 
behind the scenes, 
for example – it can 
take your Mac longer 
to boot up. Again, if 
you don’t need the 
application, getting 
rid of it (and its 
accompanying login 
item) may bring you 
to the Desktop a 
little bit more quickly 
when you first start 
your Mac.

And open applica-
tions can suck on 
the CPU as well. For 
instance, I have 
Microsoft Word open 
while I type this entry 
in BBEdit. Word’s 
doing absolutely 
nothing, as far as I 
can tell, yet Activity 
Monitor tells me that 
it’s using between 3 
and 4% of the CPU. 
And I’ve found that 
if I leave a browser 
open for days on 
end, performance 
can wane as 
well. Quitting and 
relaunching the 
browser helps.

For helpful hints 
served up multiple 
times each week, 
visit the Mac 911 
Weblog.

–Christopher Breen

LIMac guys guys line up for raffle tickets: 

http://www.macsales.com
http://www.softpress.com
http://www.havehost.ca
http://www.havehost.ca
http://www.nostarch.com
http://www.applemugstore.com
http://www.applemugstore.com
http://homepage.mac.com/ugab/resources.html
http://www.miglia.com/products/video/tvmicro/index.html
http://www.miglia.com/products/video/tvminihd/index.html
http://www.miglia.com/products/video/tvmax/index.html
http://www.miglia.com/products/communication/dialogplus/index.html
http://www.miglia.com/products/audio/harmonyaudio/index.html
http://www.miglia.com/products/audio/microsound/index.html
http://www.miglia.com/products/audio/diva21/index.html
http://www.applemugstore.com
http://www.macworld.com/weblogs/mac911/
http://www.macworld.com/weblogs/mac911/
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LIMac E-mail 
Address Updates:
Some people have 
changed servers 
(so our e-mails 
bounce back). If 
you have an e-mail 
address and have 
not been getting our 
reminders, please 
e-mail aboutlimac@
aol.com (Donald 
Hennessy) and use 

“LIMac e-mail update” 
as the subject. 

The LIMac On-Line Forum/JANUARY 2007

Give to LIMac by searching the Internet
There is a new search engine called Goodsearch.
com that donates 50% of its revenue to charities 
and schools designated by its users.

LIMac is now a member – and Goodsearch will 

donate to us about one cent for every search our 
members make via GoodSearch.

A penny does not sound like a lot, but the site 
is all about numbers — the more LIMac members 
use Goodsearch for their Internet searches, the 

more money we will raise.
For example, if our members use the 

GoodSearch search engine, and do five Web 
searches a day, LIMac could raise more than 
$1,200!

Think of all the money that could be raised 
while you and your friends and family are surfing 
the Web!

Come to the January meeting and find out 
more about GoodSearch! 0

(Q&A Continued from Page 3) 

it would fit. The problem still remains, that 
your DVD player has to be able to read your 
disc, so check it’s user guide and see if it can play 
DVD+R DL, or DVD-R or DVD+R discs. Some 
only like DVD+R, not the usual type of blank 
Mac users buy. I recently moved up to a Sony 
DVD changer that likes the DVD+R DL discs 
as well as the single layer types my previous 
Sony played. (Can I brag here? It upconverts to 
HDTV’s 1080i and outputs via HDMI to my new 
46" Sharp AQUOS LCD TV. It was only $130)
| What is the situation with ATM and 
SuperATM now with Mac OS X?
There isn’t any. There were not upgraded for 
use with OS X, and by “SuperATM” I assume 
you mean ATM Deluxe. Mac OS X, has from 
day one, smoothly rendered Postscript fonts 
on screen at any size, thus killing the need for 
ATM. ATM Deluxe, which added an excellent 
font manager was not upgraded for OS X use, 
but the other commercial font managers were. 
I prefer using Extensis’ Suitcase Fusion 12.1.3, 
but there is also Insider Software’s FontAgent 
Pro 3.3, both of these are Universal Binary for 
the modern Intel based Macs. Not so up-to-
date, but compatible for Mac OS X 10.4 is Alsoft 
MasterJuggler 3.0.4. A popular and free option 
is Linotype FontExplorer X 1.1 which works on 
PPC and Intel-based Macs. It auto-activates 
fonts in QuarkXPress 7, Adobe Illustrator and 
InDesign CS2. Not as feature-rich as Suitcase, 
but it is the best free choice that auto activates. 
Using Apple’s provided Font Book allows you 
to manually activate fonts and sets of fonts, but 
in my experience, no professional wants to do 
that. Besides, workgroups need to make sure 
everybody has the same selection of fonts, and 
Extensis sells Suitcase Server, and the freebie 
FontExplorer X is for one machine only.
| I have a file of images (90% are .jpg but 
there are some .png files) about 34MB in size 
I tried to e-mail to someone and it reported 
it was too large, so I broke it into smaller 
pieces and again it said it couldn’t be sent. 
I’m using Apple’s Mail program. Is there a 

setting I can fix to allow this to go through?
No. And the problem is not really with the 
program, but the mail server system. Usually 
they will have a limit of 10MB attachments, 
including encoding and also the recipient’s 
mailbox would be limited to 10MB size. If you 
were to try to actually e-mail than burning a 
CD and mailing it, you can try stuffing and 
segmenting the file, or making a .zip archive 
and using something like Split & Concat to 
break up that still-large file into chunks the 
system can handle. That size is about a 7MB 
file, because Mail will encode the attachment 
as binhex to a Mac user or as a mime file to a PC 
user, which makes it larger. Even if you do that, 
and the recipient diligently checks his e-mail 
and removes it from his mail server to keep in 
inbox empty, so you can fill it up with your first 
e-mail with large attachment, you have to wait 
for him to reply that he got the first segment 
before you can send the next. If you didn’t wait 
for him to reply, his inbox would be full and 
could not accept the queued second and third 
segments. If you both had gmail accounts, 
which can only be gotten via an invitation from 
an existing user, then their mail system allows 
for 100MB of storage and 100MB e-mail attach-
ments. Another option would be to sign up for 
a .Mac account. There is a free trial period. You 
can then upload the big file (doesn’t have to be 
segmented) to the public folder on the iDisk 
and have the other person download it. You can 
also use a free service like: www.sendspace.com. 

In a similar fashion, you can try file sharing 
on your Mac and grant the other person access 
to your computer and they can copy it directly 
off your machine. Now if you have a series of 
small file size images and it’s not a problem to 
break them up arbitrarily, then you can select 
somewhat less than 7MB of them and e-mail 
that batch, wait for the reply and send another 
7MB batch until it’s all done. You can include 
text in the body of the e-mail, how these files 
should be regrouped in folders. 0

http://www.sendspace.com
http://www.goodsearch.com/
http://www.goodsearch.com/
mailto:aboutlimac@aol.com?subject=LIMac e-mail update
mailto:aboutlimac@aol.com?subject=LIMac e-mail update
http://www.sonystyle.com/is-bin/INTERSHOP.enfinity/eCS/Store/en/-/USD/SY_DisplayProductInformation-Start?ProductSKU=DVPNC85H%2fB&Dept=tvvideo&CategoryName=hav_DVD_DVDPlayers
http://www.sonystyle.com/is-bin/INTERSHOP.enfinity/eCS/Store/en/-/USD/SY_DisplayProductInformation-Start?ProductSKU=DVPNC85H%2fB&Dept=tvvideo&CategoryName=hav_DVD_DVDPlayers
http://www.sharpusa.com/products/ModelLanding/0,1058,1745,00.html
http://www.xs4all.nl/~loekjehe/Split&Concat/index.htm
http://www.extensis.com/en/products/font_management/product_information.jsp?id=1060
http://www.insidersoftware.com/FA_pro_osx.php
http://www.insidersoftware.com/FA_pro_osx.php
http://www.alsoft.com/MasterJuggler/index.html
http://www.linotype.com/fontexplorerX
http://www.mac.com/WebObjects/Welcome
http://www.quark.com/products/xpress/
http://www.adobe.com/products/illustrator/
http://www.adobe.com/products/indesign/
http://www.apple.com/macosx/features/fontbook/
http://www.extensis.com/en/products/font_management/product_information.jsp?id=prod160011



